


- Please be sure to read and understand Precautions and Introductions in CX-Programmer Operation Manual before
using the product.

- This Guide describes the basic operation procedure of CX-Programmer. Refer to the Help or the Operation Manual
of the PDF file for detailed descriptions.

- Acrobat Reader 5.0 or later is required to read the PDF files.

- You can display the PDF files from the  [Start] menu on your desktop after installing the CX-Programmer.

- The screen views used in this guide may be different from the actual view, and be subject to change without notice.

- The product names, service names, function names, and logos described in this guide are trademarks or 
registered trademarks of their respective companies. 

- The symbols (R) and TM are not marked with trademarks and registered trademarks in this guide respectively

- The product names of the other companies may be abbreviated in this guide.

Introduction
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Available PC

Hardware Requirements

*2: Required memory (RAM) size depends on the size of your programs to be created. If the required memory (RAM) size is larger than 
your PC’s memory (RAM) size, operation of CX-Programmer might be slowed down.

*1: The following restrictions apply when CX-Programmer is used with Windows Vista.
Help files with an HLP file name extension cannot be accessed. These help files can be accessed if the program distributed by 
Microsoft for Windows Vista is installed. Refer to the Microsoft homepage listed below or contact Microsoft for details on installing the 
file. The download page is automatically displayed if an HLP help file is opened while the user is connected to the Internet.
http://support.microsoft.com/kb/917607/en-us

Windows 2000 Service Pack 2 or later 
/Windows XP

PC IBM PC/AT Compatible

CPU
DOS/V (IBM AT compatible) computer with a 
Pentium II 333 MHz processor or higher. 
Pentium III 1GHz or higher is recommended.

Hard disk space 550MB or more free space

Display 800X600 SVGA or grater

CD-ROM /DVD-ROM drive At least one drive

Communications Port At least one USB Port or RS-232C Port

OS
Item

256MB or higher required. 
512MB or higher is recommended.

Windows Vista *1

Memory *2

IBM PC/AT or compatible with a processor 
recommended by Microsoft.

Processor recommended by Microsoft.
1 GB or higher is recommended.

512MB or higher required.

1GB or higher is recommended.

For details of PC in which CX-One can be installed, refer to “CX-One Setup Manual”, Section 2 ”Installation and Uninstallation”.



Series CPU Unit Type

*1: For WS02-CXPC2-V (one license (limited to micro PLCs)), only these PLC types are available.
*2: CX-Programmer does not support SFC.
*3: To connect with SYSMAC Board, specify the PLC types in parentheses.  Only when selecting these PLC types, 

you can select “SYSMAC Board” as a network type.
*4: To connect with SYSMAC CS1 Board, specify PLC types in parentheses.  Only when selecting these PLC types, 

you can select “CS1 Board” as a network type.

CX-Programmer supports the following PLC (Programmable Logic Controller) types.

Available Device Types

CS1H-CPU67/66/65/64/63 (-V1)
CS1G-CPU45/44/43/42 (-V1)
CS1G-CPU45H/44H/43H/42H
CS1H-CPU67H/66H/65H/64H/63H
CS1D-CPU67H/65H/CPU67S/65S/44S/42S
CJ2H-CPU68-EIP/67-EIP/66-EIP/65-EIP/64-EIP
CJ1G-CPU45/44
CJ1M-CPU23/22/21/13/12/11
CJ1G- CPU45H/44H/43H/42H 
CJ1H-CPU66H/65H
CJ1H-CPU67H-R/66H-R/65H-R/64H-R
C1000H-CPU01 (-V1)
C2000H-CPU01 (-V1) (Simplex system only)
C200H-CPU01/02/03/11/21/22/23/31
C200HX-CPU34/44/54/64
C200HG-CPU33/43/53/63
C200HE-CPU11/32/42
C200HX-CPU34-Z/CPU44-Z/CPU54-Z/CPU64-Z/CPU65-Z/CPU85-Z
C200HG-CPU33-Z/CPU43-Z/CPU53-Z/CPU63-Z
C200HE-CPU11-Z/CPU32-Z/CPU42-Z
C200HS-CPU01/03/21/23/31/33
CP1H-X /XA /Y
CP1L-M /L
CPM2A-20CD/30CD/40CD/60CD
CPM2C-10CD/10C1D/20CD/20C1D
CPM2C-S100C/110C
CPM2C-S110C-DRT
CPM1(A)-10CDR/20CDR/30CDR/40CDR (-V1)
CQM1H-CPU11/21/51/61
CQM1-CPU11/21/41/42/43/44/45
CV1000-CPU01 (-V1)
CV2000-CPU01 (-V1)
CV500-CPU01 (-V1)
CVM1-CPU01/11 (-V1) (-V2)/CPU21-V2
IDSC-C1DR-A/C1DT-A
SRM1-C01/C02 (-V1) (-V2)
C200PC-ISA01 (C200HG-CPU43  *3)
C200PC-ISA02-DRM (C200HG-CPU43  *3)
C200PC-ISA02-SRM (C200HG-CPU43  *3)
C200PC-ISA03 (C200HG-CPU43 *3)
C200PC-ISA03-DRM (C200HG-CPU43 *3)
C200PC-ISA03-SRM (C200HG-CPU43 *3)
C200PC-ISA13-DRM (C200HX-CPU64  *3)
C200PC-ISA13-SRM (C200HX-CPU64  *3)
CS1PC-PCI01-DRM (CS1G-CPU45  *4)
CS1PC-PCI01H-DRM (CS1G-CPU45H *4)

FQM1-CM001/MMA21 / MMP21

CS

CJ

C1000H
C2000H
C200H
C200HX
C200HG
C200HE
C200HX-Z
C200HG-Z
C200HE-Z
C200HS
CP1H/CP1L

CPM2 (*1)

CPM2C-S1 (*1)

CPM1/CPM1A (*1)
CQM1H
CQM1
CV1000 (*2)
CV2000 (*2)
CV500 (*2)
CVM1
IDSC
SRM1 (*1)
SYSMAC Board, or 
SYSMAC CS1 Board
(Internal connection of a 
PC with the SYSMAC 
board that is built-in the PC 
where CX-Programmer is 
installed)

FQM1 Series Flexible 
Motion Controller







Before installation of CX-Programmer, you must:
• terminate all Windows programs, and
• uninstall older version of CX-Programmer and peripheral tools (such as CX-Protocol) if 

they are already installed.
• Installation takes about 5 to 20 minutes depending on your PC. (5 minutes for a PC with 

CPU: Celeron2.2GHz, main memory: 512MB, and CD-ROM drive: 48x)
• To change/modify/delete CX-Programmer after installation, refer to the PDF manual “CX-

Programmer Operation Manual”, Chapter 2 ”Installation and Uninstallation”.

Before installation of CX-Programmer, you must:
• terminate all Windows programs, and
• uninstall older version of CX-Programmer and peripheral tools (such as CX-Protocol) if 

they are already installed.
• Installation takes about 5 to 20 minutes depending on your PC. (5 minutes for a PC with 

CPU: Celeron2.2GHz, main memory: 512MB, and CD-ROM drive: 48x)
• To change/modify/delete CX-Programmer after installation, refer to the PDF manual “CX-

Programmer Operation Manual”, Chapter 2 ”Installation and Uninstallation”.

Insert the CX-Programmer installation disk (CD-ROM) to your PC’s CD-ROM drive.
[Choose Setup Language] dialog box is displayed. Default language of the OS on your PC is 
automatically selected.
Check if the language is appropriate, then click [OK].

Click [OK].

CX-Programmer splash screen is displayed, then CX-Programmer installation is started.

1. Installation procedure of CX-Programmer

1-1. Installing CX-Programmer

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 

new project
Device type 

settings
Device type 

settings
Creating a 
program

Creating a 
program



Click [Next].

CX-Programmer setup wizard is started.

[License Agreement] dialog box is displayed.
Read the software license agreement carefully. If you agree with all items, select [I accept 
the terms of the license agreement] radio button and click [Next] button.

Select the radio button.

Click [Next].

[User information] dialog box is displayed.

Enter [User], [Company], 
[License] (product serial 
number of CX-
Programmer).

Click [Next].

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 

new project
Device type 

settings
Device type 

settings
Creating a 
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Creating a 
program



[Setup Type] dialog box is displayed.

Select an installation 
folder, then click [Next].

By selecting [Custom], you can 
individually select and install a 
peripheral tool.

[Ready to Install the Program] dialog box is displayed.

Read the message and 
click [Next].

Click [Install].

CX-Programmer installation is started.

Select the radio button 
[Complete].

Click [Next].

[Choose Destination Location] dialog box is displayed.

If OMRON FB Library is selected, [Choose Destination Location] dialog box of OMRON FB 
Library  is displayed.
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to Startup
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Click [Finish].

A dialog box (left) is displayed.
Click [Finish] button to finish the 
installation wizard.
Now installation is completed.

By checking [Online registration] 
check box, you can proceed to 
online registration.

Installation 
to Startup

Installation 
to Startup

Opening a 
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If you have Internet environment for the installed PC, you can perform online user registration.

After installation is completed, [Online Registration] dialog box is displayed.

If you click [Register] button, your Web browser is started to connect to “Omron’s CX-One Web 
site”.(*1) (*2)
*1: If you click [Exit] button to cancel online registration, [Online Registration] dialog box is 
displayed every time CX-Programmer is started.
*2: If you do not have Internet environment, or you do not want to register online, fill and send 
the user registration card that comes with the product.

1-2. Online Registration
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Use to record license No. etc.
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Windows task bar

[Start]
↓

[Programs]
↓

[OMRON]
↓

[CX-One]
↓

[CX-Programmer]
↓

[CX-Programmer]

2. Startup of CX-Programmer

The initial screen when starting up CX-Programmer is displayed.
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3. New Project Opening and Device Type Settings

Click the toolbar button [New] in CX-Programmer.

Click

Click the left mouse 
button on the “Settings”
button to show the 
[Device Type Settings] 
dialog.

Click the left mouse 
button.

Click the left mouse button on
and select a CPU type.

Click [OK] to decide the 
selected CPU type.

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 
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Device type 

settings
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4. Main Window

Each function of the main window is explained here.

Title Bar

Menus

Project Tree

Section

Project Workspace Ladder WindowOutput Window

Toolbars

Status Bar

Symbol Bar

Shows error information in compiling (error check).
Shows the results of searching for contacts/coils in the list form.
Shows error details when errors occurred while loading a project file.

Enables you to divide one program into a given number of blocks. Each can be 
created  and displayed.

Section

Shows information such as a PLC name, online/offline, location of an active cell.Status Bar

Output Window

A screen for creating and editing a ladder program.Ladder Window

Controls programs and data.  Enables you to copy data by the element by 
executing Drag and Drop between different projects or within a project.

Project Workspace
Project Tree

Enable you to select functions by clicking icons.  Select [View] -> [Toolbars], and 
you can select toolbars to be displayed.  Dragging toolbars enables you to change 
the display positions by the group.

Toolbars

Enable you to select menu items.Menus

Shows the file name of saved data created in CX-Programmer.Title Bar

Contents/FunctionName

Displays a small window to show the basic shortcut keys used in CX-Programmer.
Select [View] -> [Information Window] to show or hide the Information window.

Information Window

Displays the name, address or value, and comment of the symbol presently 
selected by the cursor.

Symbol Bar

Information Window



The keyboard mapping function allows the function keys to operate like SYSWIN.

Select the [Tools] -> [Keyboard Mapping...] menu.

Click

Click

When SYSWIN key allocation is selected, a key operation guide will be displayed at the bottom of the display.When SYSWIN key allocation is selected, a key operation guide will be displayed at the bottom of the display.

Display in Full View

Right mouse-click

Display in Normal View

When Alt is pressed

When Shift is pressed

When Ctrl is pressed

4-1. Compatible SYSWIN Key Allocation

After the above operations, 
the key allocations will be 
changed and become 
compatible with SYSWIN.

Click the icon shown in 
the task bar on the right-
bottom of the display.

Function keys will be 
available for entering 

ladder programs.

Click



4-2. Section

Section is a function to create/display a “block” of a program divided per function.  It 
improves not only the visibility of a program but also the development productivity by 
reusing components if the program consists of similar controls, because copy and paste on 
the program tree are available.
Moreover, program upload by section is possible and it enables you to do online operation 
smoothly.

Giving names 
indicating the contents 
of processing or 
controls is possible.

There is no limit on the 
number of sections per 
program.

Changing a section name

Click the right 
button of the 
mouse on the 
section whose 
name is to be 
changed.

Select [Rename].

Changing the order of 
sections and copy & paste 
are possible by drag & 
drop with a mouse.

Example

Enter a given name.



Addition of a section

Click the right 
mouse button on 
[NewProgram1].

Select [Insert 
Section].

It is possible to go to each section (a ladder block) from a section list.

Perform the same 
operation as the 
previous page to 
name the inserted 
section.

Double-click a 
section that 
you want to 
check its 
ladder.

As checking the global image (control flow) of a program on the section list, you can go to a specified section. 



4-3. Deletion and Display of Unnecessary Windows

Normal screen

Alt 1

Press from a keyboard

To delete Project 
Workspace, 

Press [Alt]+[1] to 
show Project 
Workspace again.

Alt 2

Press from a keyboard

To delete Output 
Window,

Press [Alt]+[2] to 
show Output 
Window again.

[ESC] or 



5. Program Creation
Coding of a simple program is explained here.



After checking the cursor position at the upper left of Ladder Window, start programming.

5-1. Entry of Normally Open Contact

Press [C] from a keyboard to open the [New Contact] dialog.C

0
0 of the upper 
digit of an 
address can 
be omitted.

ENT

Switch 1

Enter a symbol 
comment.ENT

0 of the upper digit of an address is omitted when shown.
[.] (period) is displayed between a channel number and a relay number.

Deletion of instructions
Move the cursor to the instruction
and then press the DEL key.
Move the cursor to the right cell of
the instruction and press the BS key.

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
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settings
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Output Window 
automatically opens.

5-2. Entry of Coil

Press [O] from a keyboard to open the [New Coil] dialog.O

100

ENT

Coil 0

ENT

Press [R] to normalize a rung.

R

Useful Function: Automatic check of duplicated coils
If a duplicated coil is entered during program creation, the following message is 
displayed and you can notice that the coil is duplicated right away.

Useful Function: Automatic check of duplicated coils
If a duplicated coil is entered during program creation, the following message is 
displayed and you can notice that the coil is duplicated right away.

Press the [ESC] key to close 
the open Output Window.

The place of a duplicated coil in the program is displayed.

Double-click by using a mouse (or press F4).  The cursor 
moves to the place of the applicable coil on Ladder Window.

Double-clickDouble-click

Rungs are also normalized when you move the 
cursor position to the cell inverted in blue by 
pressing the arrow keys from a keyboard or 
using a mouse.
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[Reference]
1. Press [Alt]+[Y].  You can switch showing/hiding of Symbol Comment.

Alt Y

[Tools] -> [Options]

3. Select [Tools] | [Options] from the CX-Programmer menu.  You can set hiding 
of the comment entry dialog.

Click the check box 
to remove the check 
mark.

The comment entry 
dialog is not displayed 
anymore.

2. Click the toolbar button [Show Program/Section Comments] to switch the 
display of the comments shown in the head row.

Click

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 

new project
Device type 

settings
Device type 

settings
Creating a 
program

Creating a 
program



5-3. Edit of Symbol Comment

Click

Ladder Window is 
switched to the Symbol 
Comment Editing 
window.

Double-click the left 
mouse button on a bit 
number that you want to 
enter a symbol comment, 
and you will able to enter 
a symbol comment.

Example of copying & pasting comments of two bitsDrag the mouse with the 
right mouse button 
pressed to invert the 
source bits of copy in 
blue.

Click the right 
mouse button on 
the range, and 
select [Copy] from 
the popup menu.

Click the right mouse button 
on the bit number of the copy 
destination, and select [Paste].

The comments of the selected 
two bits are copied.

Copy&Paste of symbol 
comments is possible between 
Excel and CX-Programmer too.

Copy&Paste of symbol 
comments is possible between 
Excel and CX-Programmer too.

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 

new project
Device type 

settings
Device type 

settings
Creating a 
program

Creating a 
program

Copy&Paste and deletion of one or more comments are possible by the cell.Copy&Paste and deletion of one or more comments are possible by the cell.



5-4. Entry of Rung Comment

Move the cursor to this 
position. (The rung is 
inverted in blue.)

ENT

The entry screen 
shows up.

[Process_at_Startup]
Enter a rung comment.

ENT

5-5. Entry of Normally Closed Contact

/

1

ENT

Sensor 1

ENT

Press “/” from a keyboard to show the [New Closed Contact] dialog.

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 

new project
Device type 

settings
Device type 

settings
Creating a 
program

Creating a 
program



O 101

ENT Coil 1

ENT R

5-6. Entry of Attached Comments

This function is very useful for keeping change histories at maintenance and notes 
of debug bits at startup.

Move the cursor to 
the contact to which 
you want to write an 
annotation.

Alt ENT

Or click the right 
mouse button. 
-> [Properties]

The entry screen shows up.

Enter [Mar. 2002 
Added by Tanaka, 
Maintenance Dept.].

ENT
Press [Alt] + [A] to switch 
showing/hiding of 
attached comments.

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 

new project
Device type 

settings
Device type 

settings
Creating a 
program

Creating a 
program



5-7. Entry of Differential Contact…Up

C

100

ENT

Click

Click [Up].

ENT
This entry method is available only for 
CS/CJ and CV series PLCs.
For the other series PLCs, use DIFU (13).

5-8. Entry of Differential Contact…DownC

101

ENT

Click

This entry method is available only for 
CS/CJ and CV series PLCs.
For the other series PLCs, use DIFD (14).

Click [Down].

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 

new project
Device type 

settings
Device type 

settings
Creating a 
program

Creating a 
program



5-9. Entry of Vertical…Up

Ctrl ↑

Or

U

O 200

ENT Coil 2

ENT R

5-10. Entry of Vertical…Down

C 200

ENT ENT

ENT

Coil 3

O 300

ENT

←

Ctrl ↓

Or

V
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to Startup

Opening a 
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Opening a 
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Device type 

settings
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settings
Creating a 
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Creating a 
program



5-11. Entry of Advanced Instructions 1 - Entry of Strings 

I

ENT

R

Show the [New Instruction] dialog.

++   d0

Products ENT

Enter an instruction and its operand.

Enter a comment.

See the next page for 
the contents of 
instructions.

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 

new project
Device type 

settings
Device type 

settings
Creating a 
program

Creating a 
program



Click

Click             

.                       
The reference guide screen of the 
instruction shows up.

Instruction Help Function

Click                                   .

The list of advanced instructions 
per function shows up.

Find Instruction Function

PLCs supporting the applicable 
instruction are listed.

5-12. Entry of Advanced Instructions 1 - Useful Functions

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 

new project
Device type 

settings
Device type 

settings
Creating a 
program

Creating a 
program



C

ENT

5-13. Entry of Auxiliary Relay - 1.0 Second Clock Pulse Bit

Show the [New Contact] dialog.

Click

Select [P_1s] from the 
pull-down menu.

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 

new project
Device type 

settings
Device type 

settings
Creating a 
program

Creating a 
program



ENT

5-14. Entry of Advanced Instructions 2
- Entry of Differential Instructions

Differential Instructions…Instructions executed 
in only one scan when running a program.

I

Show the [New Instruction] dialog.

Attach @ (at mark) 
before instructions.  It 
makes the instructions 
differential. 

Attach @ (at mark) 
before instructions.  It 
makes the instructions 
differential. 

Enter a comment if necessary.

ENT

R

Refer to the former 
pages to execute 
coding.

Enter
@MOV    #0

D100

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 

new project
Device type 

settings
Device type 

settings
Creating a 
program

Creating a 
program



5-15. Entry of OR Rung

ENT

W 3

ENT

Refer to the former 
pages to execute 
coding.

ENT

ENT

W 4

ENT ENT

Entry of 
comments is 
omitted here.

Refer to the section 5-
6 to enter annotations.
Refer to the section 5-
6 to enter annotations.

↑

↑

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 

new project
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settings
Device type 

settings
Creating a 
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Creating a 
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5-16. Entry of Advanced Instructions 3 - Entry by Fun No.

Show the [New Instruction] dialog.Show the [New Instruction] dialog.

I

021

ENT
Enter
#0 D0

The instruction 
corresponding to the 
entered Fun No. is 
displayed.

The instruction 
corresponding to the 
entered Fun No. is 
displayed.

ENT

R

Refer to the section 5-4 to enter a rung comment.

Note:
The Fun No. of MOV 
depends on PLC types.
CS-series -> 021
CJ-series -> 021
CV-series -> 030
C-series -> 21

Note:
The Fun No. of MOV 
depends on PLC types.
CS-series -> 021
CJ-series -> 021
CV-series -> 030
C-series -> 21
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Installation 
to Startup

Opening a 
new project
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settings
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settings
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5-17. Entry of Timer Instructions

Refer to the former 
pages to enter 
rungs and 
comments.

Refer to the former 
pages to enter 
rungs and 
comments.

/ ENT

ENT

T0
*T0: Indicates TIM0.

Enter a comment.

Timer 1

Entry of a Timer bit

Entry of a Timer instruction

I

TIM   0   #30

ENT

R

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 

new project
Device type 

settings
Device type 

settings
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Creating a 
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C0

5-18. Entry of Counter Instructions

Refer to the former 
pages to execute 
coding.

Refer to the former 
pages to execute 
coding.

I

CNT   0   #5

ENT

R

Move the cursor by 
using arrow keys or a 
mouse.
Enter a bit for reset.

C ENT

R

402O ENT

Entry of a Counter instruction

Entry of a Counter bit
ENT

ENT

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 

new project
Device type 

settings
Device type 

settings
Creating a 
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Creating a 
program



5-19. Edit of Rungs …Copy & Paste 

Refer to the former sections to enter a rung.

Ctrl C

Move the cursor to 
this position.  The 
rung is inverted as 
shown right.

Move the cursor to 
this position.  The 
rung is inverted as 
shown right.

(Copy a rung) You can copy instructions selected by dragging a mouse.
You can also cut selected rungs (instructions) by [Ctrl]+[X].

↓

Press the ↓ key to 
move the cursor to 
this position.

Press the ↓ key to 
move the cursor to 
this position.

Ctrl V

(Paste a copied rung)

Click each instruction 
and then change the 
bit numbers.

Click each instruction 
and then change the 
bit numbers.

When making a mistake, press       or [Ctrl+Z] for Undo 
(return to the previous operation)

press        or [Ctrl+Y] for Redo (go to the next operation)

Installation 
to Startup

Installation 
to Startup

Opening a 
new project
Opening a 

new project
Device type 

settings
Device type 

settings
Creating a 
program

Creating a 
program

5-20. Entry of END Instruction

At the creation of a new project, a 
section of the END instruction only is 
automatically generated.
You do not need to enter an END 
instruction.

At the creation of a new project, a 
section of the END instruction only is 
automatically generated.
You do not need to enter an END 
instruction.

Note:
The END section is not generated when you load a program 
created with CX-Programmer V2 or  the former versions.





Online 
to Transfer

Online 
to Transfer MonitoringMonitoring Force On

Force Off
Force On
Force Off

Program
Check

Program
Check

Online
Edit

Online
Edit

1. Program Error Check (Compile)

Before program transfer, check errors.

Click

Errors and addresses 
are displayed on 
Output Window.

Errors and addresses 
are displayed on 
Output Window.

Double-click a 
displayed error, and 
the cursor in Ladder 
Diagram will go to the 
corresponding error 
location and the error 
rung will be shown in 
red.

Double-click a 
displayed error, and 
the cursor in Ladder 
Diagram will go to the 
corresponding error 
location and the error 
rung will be shown in 
red.

Modify the error.Modify the error.
Output Window automatically opens at program check.
The cursor moves to an error location by pressing J or F4 key.
Output Window closes by pressing the ESC key.
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Online 
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Force Off
Force On
Force Off
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Check

Program
Check

Online
Edit

Online
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2. Going Online

Normal online.  Enables you to go online with a PLC of the device type and method specified when opening a project.Normal online.  Enables you to go online with a PLC of the device type and method specified when opening a project.

Auto online.  Automatically recognizes the connected PLC and enables you to go online with a PLC with one button. 
-> Uploads all data such as programs from the PLC.

Auto online.  Automatically recognizes the connected PLC and enables you to go online with a PLC with one button. 
-> Uploads all data such as programs from the PLC.

Online with Simulator.  Enables you to go online with CX-Simulator with one button (You need to install CX-Simulator.)Online with Simulator.  Enables you to go online with CX-Simulator with one button (You need to install CX-Simulator.)

This time, online/debug 
functions when working 
online with CX-Simulator 
are explained in this 
guide (Install CX-
Simulator separately).

This time, online/debug 
functions when working 
online with CX-Simulator 
are explained in this 
guide (Install CX-
Simulator separately).

Click [OK].

Click [OK].

The background color 
of Ladder Window 
changes to gray.

The background color 
of Ladder Window 
changes to gray.

Scan time is displayed
(except for Program Mode).
Scan time is displayed
(except for Program Mode).

The operating mode 
of the active PLC is 
shown.

The operating mode 
of the active PLC is 
shown.

Click

The CX-Simulator 
Console box is 
shown.

The CX-Simulator 
Console box is 
shown.

CX-Programmer provides three kinds of connecting methods depending on usage.

Program transfer starts.
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3. Monitoring

The on/off statuses of contacts and coils are monitored.

Click

Change the PLC 
(simulator) to 
Monitor Mode.

Change the PLC 
(simulator) to 
Monitor Mode.

Click [Yes].

If your program has a large volume of 
data,  the scroll speed of the screen 
may become slow when monitoring.
In that case, click the below icon to 
cancel monitoring once, scroll the 
screen to the address you want to 
monitor, and then change to 
monitoring mode again.

toggles on/off of PLC monitoring.

The rungs being 
monitored are shown 
in a specified color.

The rungs being 
monitored are shown 
in a specified color.

The present value of 
I/O memory is shown.
The present value of 
I/O memory is shown.



4. Monitoring - 2  Monitoring Many Locations in Program at Once

You can split Ladder Window and monitor more than one location in a program at once.
Move the mouse 
pointer to the arrow 
position shown in the 
right figure and drag 
the cursor down with 
the left mouse button 
pressed.

Move the mouse 
pointer to the arrow 
position shown in the 
right figure and drag 
the cursor down with 
the left mouse button 
pressed.

The screen is divided 
into two panes up 
and down, and you 
can display any 
address in two panes 
respectively by using 
the scroll bars.

The screen is divided 
into two panes up 
and down, and you 
can display any 
address in two panes 
respectively by using 
the scroll bars.

5. Monitoring - 3  Monitoring in Hex

Click            to switch the display format of the present value of IO memory between 
decimal and hexadecimal.
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Shown in decimal

Shown in hex



ENT

Alt 3

6. Monitoring - 4  Watch Window

I/O monitoring of the addresses specified in Watch Window is executed.

Display Watch 
Window.

Enter a bit number 
that you want to 
monitor. 400

Press the ENT key 
continuously for auto 
increment of addresses.

You can also enter a given 
address in this status.
You can also enter a given 
address in this status.

ENT
ENT

ENT
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to Transfer MonitoringMonitoring Force On

Force Off
Force On
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Entry of BOOL type (contact)Entry of BOOL type (contact) Example: Entry of 4CH 00Bit

Or enter “400” without a period in the “Name or 
address” box and then specify “BOOL” in the “Data 
Type/Format” box (Reverse the box and then press B 
key form the keyboard.)

Or enter “400” without a period in the “Name or 
address” box and then specify “BOOL” in the “Data 
Type/Format” box (Reverse the box and then press B 
key form the keyboard.)

Enter “.” (period) between CH and Bit.Enter “.” (period) between CH and Bit.

The addresses registered in Watch Window are still stored 
when CX-Programmer is opened next time.
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7. Monitoring - 5  Present Value Change and Binary Monitoring in Watch Window

In Watch Window, binary monitoring is possible for the data that can be 
treated by the word.

Double-click the mouse.

The present values of bits and words are changed in Watch Window.

An entry dialog 
opens.

Enter a new 
value that you 
want to change to.

Click

4-word data is 
displayed in the 
binary system.

4-word data is 
displayed in the 
binary system.

Click the right mouse button 
on a bit, and you will be able 
to select Force On/Off and 
Set On/Off from the popup 
menu.As shown in the guidance at 

the bottom of the dialog, 
Force On/Off and Set On/Off 
are enabled also by key 
operation.



8. Useful Functions of Watch Window

Click the right button 
of a mouse on Sheet1, 
and then select 
[Watch Sheet] -> 
[Rename].

Click the right button 
of a mouse on Sheet1, 
and then select 
[Watch Sheet] -> 
[Rename].

To add a sheet, 
select [Watch sheet] 
-> [Insert].

To add a sheet, 
select [Watch sheet] 
-> [Insert].

Watch Window has a function that classifies and displays data in sheets like MS-
EXCEL and names each sheet given names.
This function is useful for debug or startup if you gather and manage the bits and words
you want to check as one block in one sheet. 

Click [OK].Click [OK].

It is useful to manage data if you name sheets by the 
phase or assembly.

The names set by this operation are all saved when the project is saved (extension: .opt).
Therefore, they are loaded as well as data such as ladder programs when the project is 
loaded next time.

The names set by this operation are all saved when the project is saved (extension: .opt).
Therefore, they are loaded as well as data such as ladder programs when the project is 
loaded next time.
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Enter a name.Enter a name.

Right-click on Watch Window. -> Select 
[View] from the popup menu.  And then you 
will be able to choose showing/hiding of each 
item on Watch Window.

Right-click on Watch Window. -> Select 
[View] from the popup menu.  And then you 
will be able to choose showing/hiding of each 
item on Watch Window.



9. Monitoring - 6  Watch Window - 2

Drag & Drop from Ladder Diagram enables you to add an address to be monitored.Move the mouse 
cursor to this 
position.

Move the mouse 
cursor to this 
position.

Drag and drop on Watch 
Window.
Drag and drop on Watch 
Window.

Data such as rungs, bits per block, or operands of advanced instructions is 
pasted on Watch Window.
Moreover, the on/off statuses of the bits and the present values of words 
are displayed.

Data such as rungs, bits per block, or operands of advanced instructions is 
pasted on Watch Window.
Moreover, the on/off statuses of the bits and the present values of words 
are displayed.
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10. Monitoring - 7  Rung-wrap of Long Rung on Display

This function makes a rung longer than the right bus bar as shown in the below figure 
wrap when displayed.

Select [View] -> 
[Show in 
RungWrap].

The rung is wrapped at the right bus bar.

Once set, this function is always active until released by taking the reverse 
procedure of the above one. 
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11. Monitoring - 8  Differential Monitor

The function detects differential up/down of a specified bit and indicates that 
differential conditions are satisfied by sound or display. 
The function eliminates the use of  a trap rung for checking operation and 
improves the efficiency of programming and debug operations.

Click

Or click the right mouse 
button on the applicable 
bit and select 
[Differential Monitor] 
from the popup menu.

Move the cursor to a 
bit to be monitored.

Click [Start].

The count number is displayed on the 
dialog every time the differential 
condition (differential up in this 
example) is satisfied and the color of 
the box changes each time.

The count number is displayed on the 
dialog every time the differential 
condition (differential up in this 
example) is satisfied and the color of 
the box changes each time.
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12. Force On/Off

Contacts/coils are forced on/off from CX-Programmer.
Move the cursor to a 
contact or coil that you 
want to force on/off.

Click the right mouse 
button. ->
[Force] -> [On]

Click the right mouse 
button. ->
[Force] -> [On] mark indicates that the bit is 

now being forced on/off.

13. Displaying List of Forced-on/off Bits

The bits forced on/off can be listed in a table.
This function enables you to check the forced statuses of more than one bit  at a glance.

Display Project 
Workspace.
[Alt] + 1

Double-click 
[Memory].

Click the 
[Address] tab.

Double-click 
[Forced Status].
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Force Off/Cancel of 
bits/coils are enabled 
in the same way.

Force Off/Cancel of 
bits/coils are enabled 
in the same way.

Once bits/coils are forced on/off, the forced statuses are held until cancelled or the 
reverse procedures of on/off are taken.
The statuses do not change by an external input or the operational result of the 
program.
Moreover, force operations are not enabled when the PLC is in the Run mode.

Shortcut Key
Ctrl+J: Force On
Ctrl+K: Force Off

Shortcut Key
Ctrl+J: Force On
Ctrl+K: Force Off
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14. Changing Set Value of Timer
The set value of a timer is changed while CPU is running (in the Monitor mode only).

Move the cursor to the 
set value of a timer.

Enter the new set value #100.

Click [OK] to complete.

15. Changing Present Value of Timer

Move the cursor to the 
present value of a 
timer.

Enter a new present value 5000.

Click [Set] to complete.

The present value of a timer is changed while CPU is running (in the Monitor mode only).

Subtraction starts from 
the new value 5000.

ENT

Or double-click.

ENT

Or double-click.



Online 
to Transfer

Online 
to Transfer MonitoringMonitoring Force On

Force Off
Force On
Force Off

Program
Check

Program
Check

Online
Edit

Online
Edit

16. Find Function - 1  Find from Address Reference Tool

Alt 4

Display Address 
Reference Tool.

Click

The found 
bits are listed.
The found 
bits are listed.

3

Enter a bit number that you 
want to find in the [Address] 
field.

Enter a bit number that you 
want to find in the [Address] 
field.

1

You can also move the 
cursor to a bit that you 
want to find.

You can also move the 
cursor to a bit that you 
want to find.

Click a bit that you 
want to find, and the 
focus will move to the 
corresponding position 
in the rung.

2

Reference
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17. Find Function - 2  Retrace Find of Ladders

The function retraces ladder rungs so that you can find the causes of the coils not turned on.

(1)The reason why the coil 3.00 is not turned on is that its contact 2.00 is not turned on.
Therefore, the function retraces rungs to find the coil 2.00.

(2)Move the cursor to the following position (contact 2.00) and press the [Space] key.

Space

(3)The reason why the coil 2.00 is not turned on is that the contact 1.00 or 1.01 is not 
turned on.  Suppose the cause is the contact 1.00 and find the coil of 1.00.  Move the
cursor to the contact 1.00 and press the [Space] key as well as the above operation (2).

(4)If this rung is not a cause press [Shift]+[Space], and you will able to go back to the
rung before you started to find this rung.

Space

SpaceShift
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(5)Then retrace rungs to find a cause from the contact 1.01.  As well as the operations
so far, move the cursor to the contact 1.01 and press the [Space] key.

Space

(6)The focus moves to the coil 1.01.  As it turned out, the cause was the contact 0.01
that was not turned on.

Press the [Space] key to jump from a coil to a contact having the same address as the 
coil or from a contact to a coil in reverse.

Press the [N] key for another jump from a contact or coil at the cursor position to a next 
one having the same address.
To move back to the position of the last jump, press the [B] key.

This is a useful function available in SYSMAC Support Software. 
CX-Programmer inherits it.
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18. Find Function - 3  Find by Keyword in Comment

If you enter an operator’s name or an operation date in annotations as a note at 
startup or maintenance, this function finds the bit or word that the name or date is 
used and displays the result on Output Window.

Click

The [Find] dialog 
shows up.

Click        .  
Select [All (strings)] from the 
pull-down menu.

PLC
To find a target from all tasks 
(programs).

Current view
To find from a section or task 
(program) being edited
-> Click an icon in Project 
Workspace to select a task.

Scope of Find is specifiable.

Click [OK].

Enter a keyword to 
find.

Click

Double-click an item, and then 
the cursor moves to the 
applicable bit in Ladder 
Window.

Double-click an item, and then 
the cursor moves to the 
applicable bit in Ladder 
Window.

The contacts/coils of which 
annotations include the 
keyword entered in the 
Find dialog are displayed 
on Output Window.

The contacts/coils of which 
annotations include the 
keyword entered in the 
Find dialog are displayed 
on Output Window.
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19. Find Function - 4  Go To Rung Comment

This is a function that displays a list of rung comments on the screen and moves the 
cursor to the position where a selected rung comment is used in the ladder.
Rung comments improve the efficiency of debug or maintenance of rungs divided into 
blocks per function.

A list of the rung 
comments used in 
rungs are displayed on 
a separate window.

Alt Shift R

Click a rung comment in 
the list, and the cursor 
goes to the position 
where the rung comment 
is used in the ladder.

L

Or
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20. Find Function - 5  Find Bit Addresses

Click the right mouse 
button on Ladder 
Window.  Select [Find 
Bit Addresses] from 
the popup menu.

Enter an address 
(bit number) to find. 
(period between a 
channel and a bit is 
unnecessary.)

Click the [How to 
Input] button, and 
the Help of [Find 
and Replace 
Examples] will be 
displayed.

Set the scope of 
Find (Current view).

Click [Report].

Click [OK].

Output Window is 
displayed and  the 
results are listed.

Output Window is 
displayed and  the 
results are listed.

Double-click an item 
in the list, and the 
cursor will go to the 
applicable bit.

Double-click an item 
in the list, and the 
cursor will go to the 
applicable bit.

Find Addresses and Find   
Mnemonics are also 
available.
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21. Online Edit

(1) Move the cursor to a rung you want to modify.

(2) Select [Program] -> [Online Edit] -> [Begin] from the CX-Programmer menu.

(3) Enter a bit number (4.11 in this example) you want to edit to.

(4) Select [Program] -> [Online Edit] -> [Send Changes] from the menu.

Double-clickDouble-click

End

You can also select more 
than one rung by 
Drag&Drop with a mouse.



You can select either vertical or horizontal display of output instructions.

Useful Functions

Vertical display of output instructions

[Tools(T)] -> [Options(O)]

Check the [Show 
output instructions 
horizontally (Z)] box.

Check the [Show 
output instructions 
horizontally (Z)] box.

Horizontal display of output instructions



Terms and Conditions of Sale
1. Offer; Acceptance. These terms and conditions (these "Terms") are deemed

part of all quotes, agreements, purchase orders, acknowledgments, price lists,
catalogs, manuals, brochures and other documents, whether electronic or in
writing, relating to the sale of products or services (collectively, the "Products")
by Omron Electronics LLC and its subsidiary companies (“Omron”). Omron
objects to any terms or conditions proposed in Buyer’s purchase order or other
documents which are inconsistent with, or in addition to, these Terms. 

2. Prices; Payment Terms. All prices stated are current, subject to change with-
out notice by Omron. Omron reserves the right to increase or decrease prices
on any unshipped portions of outstanding orders. Payments for Products are
due net 30 days unless otherwise stated in the invoice.

3. Discounts. Cash discounts, if any, will apply only on the net amount of invoices
sent to Buyer after deducting transportation charges, taxes and duties, and will
be allowed only if (i) the invoice is paid according to Omron’s payment terms
and (ii) Buyer has no past due amounts.

4. Interest. Omron, at its option, may charge Buyer 1-1/2% interest per month or
the maximum legal rate, whichever is less, on any balance not paid within the
stated terms.

5. Orders. Omron will accept no order less than $200 net billing. 
6. Governmental Approvals. Buyer shall be responsible for, and shall bear all

costs involved in, obtaining any government approvals required for the impor-
tation or sale of the Products.

7. Taxes. All taxes, duties and other governmental charges (other than general
real property and income taxes), including any interest or penalties thereon,
imposed directly or indirectly on Omron or required to be collected directly or
indirectly by Omron for the manufacture, production, sale, delivery, importa-
tion, consumption or use of the Products sold hereunder (including customs
duties and sales, excise, use, turnover and license taxes) shall be charged to
and remitted by Buyer to Omron.

8. Financial. If the financial position of Buyer at any time becomes unsatisfactory
to Omron, Omron reserves the right to stop shipments or require satisfactory
security or payment in advance. If Buyer fails to make payment or otherwise
comply with these Terms or any related agreement, Omron may (without liabil-
ity and in addition to other remedies) cancel any unshipped portion of Prod-
ucts sold hereunder and stop any Products in transit until Buyer pays all
amounts, including amounts payable hereunder, whether or not then due,
which are owing to it by Buyer. Buyer shall in any event remain liable for all
unpaid accounts.

9. Cancellation; Etc. Orders are not subject to rescheduling or cancellation
unless Buyer indemnifies Omron against all related costs or expenses.

10. Force Majeure. Omron shall not be liable for any delay or failure in delivery
resulting from causes beyond its control, including earthquakes, fires, floods,
strikes or other labor disputes, shortage of labor or materials, accidents to
machinery, acts of sabotage, riots, delay in or lack of transportation or the
requirements of any government authority. 

11. Shipping; Delivery. Unless otherwise expressly agreed in writing by Omron:
a. Shipments shall be by a carrier selected by Omron; Omron will not drop ship

except in “break down” situations.
b. Such carrier shall act as the agent of Buyer and delivery to such carrier shall

constitute delivery to Buyer;
c. All sales and shipments of Products shall be FOB shipping point (unless oth-

erwise stated in writing by Omron), at which point title and risk of loss shall
pass from Omron to Buyer; provided that Omron shall retain a security inter-
est in the Products until the full purchase price is paid;

d. Delivery and shipping dates are estimates only; and
e. Omron will package Products as it deems proper for protection against nor-

mal handling and extra charges apply to special conditions.
12. Claims. Any claim by Buyer against Omron for shortage or damage to the

Products occurring before delivery to the carrier must be presented in writing
to Omron within 30 days of receipt of shipment and include the original trans-
portation bill signed by the carrier noting that the carrier received the Products
from Omron in the condition claimed.

13. Warranties. (a) Exclusive Warranty. Omron’s exclusive warranty is that the
Products will be free from defects in materials and workmanship for a period of
twelve months from the date of sale by Omron (or such other period expressed
in writing by Omron). Omron disclaims all other warranties, express or implied.
(b) Limitations. OMRON MAKES NO WARRANTY OR REPRESENTATION,
EXPRESS OR IMPLIED, ABOUT NON-INFRINGEMENT, MERCHANTABIL-

ITY OR FITNESS FOR A PARTICULAR PURPOSE OF THE PRODUCTS.
BUYER ACKNOWLEDGES THAT IT ALONE HAS DETERMINED THAT THE
PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR
INTENDED USE. Omron further disclaims all warranties and responsibility of
any type for claims or expenses based on infringement by the Products or oth-
erwise of any intellectual property right. (c) Buyer Remedy. Omron’s sole obli-
gation hereunder shall be, at Omron’s election, to (i) replace (in the form
originally shipped with Buyer responsible for labor charges for removal or
replacement thereof) the non-complying Product, (ii) repair the non-complying
Product, or (iii) repay or credit Buyer an amount equal to the purchase price of
the non-complying Product; provided that in no event shall Omron be responsi-
ble for warranty, repair, indemnity or any other claims or expenses regarding
the Products unless Omron’s analysis confirms that the Products were prop-
erly handled, stored, installed and maintained and not subject to contamina-
tion, abuse, misuse or inappropriate modification. Return of any Products by
Buyer must be approved in writing by Omron before shipment. Omron Compa-
nies shall not be liable for the suitability or unsuitability or the results from the
use of Products in combination with any electrical or electronic components,
circuits, system assemblies or any other materials or substances or environ-
ments. Any advice, recommendations or information given orally or in writing,
are not to be construed as an amendment or addition to the above warranty.
See http://www.omron247.com or contact your Omron representative for pub-
lished information.

14. Limitation on Liability; Etc. OMRON COMPANIES SHALL NOT BE LIABLE
FOR SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES,
LOSS OF PROFITS OR PRODUCTION OR COMMERCIAL LOSS IN ANY
WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED IN CONTRACT, WARRANTY, NEGLIGENCE OR STRICT LIABILITY.
Further, in no event shall liability of Omron Companies exceed the individual
price of the Product on which liability is asserted.    

15. Indemnities. Buyer shall indemnify and hold harmless Omron Companies and
their employees from and against all liabilities, losses, claims, costs and
expenses (including attorney's fees and expenses) related to any claim, inves-
tigation, litigation or proceeding (whether or not Omron is a party) which arises
or is alleged to arise from Buyer's acts or omissions under these Terms or in
any way with respect to the Products.   Without limiting the foregoing, Buyer (at
its own expense) shall indemnify and hold harmless Omron and defend or set-
tle any action brought against such Companies to the extent based on a claim
that any Product made to Buyer specifications infringed intellectual property
rights of another party. 

16. Property; Confidentiality. Any intellectual property in the Products is the exclu-
sive property of Omron Companies and Buyer shall not attempt to duplicate it
in any way without the written permission of Omron. Notwithstanding any
charges to Buyer for engineering or tooling, all engineering and tooling shall
remain the exclusive property of Omron. All information and materials supplied
by Omron to Buyer relating to the Products are confidential and proprietary,
and Buyer shall limit distribution thereof to its trusted employees and strictly
prevent disclosure to any third party. 

17. Export Controls. Buyer shall comply with all applicable laws, regulations and
licenses regarding (i) export of products or information; (iii) sale of products to
“forbidden” or other proscribed persons; and (ii) disclosure to non-citizens of
regulated technology or information.    

18. Miscellaneous. (a) Waiver. No failure or delay by Omron in exercising any right
and no course of dealing between Buyer and Omron shall operate as a waiver
of rights by Omron. (b) Assignment. Buyer may not assign its rights hereunder
without Omron's written consent. (c) Law. These Terms are governed by the
law of the jurisdiction of the home office of the Omron company from which
Buyer is purchasing the Products (without regard to conflict of law princi-
ples).   (d) Amendment. These Terms constitute the entire agreement between
Buyer and Omron relating to the Products, and no provision may be changed
or waived unless in writing signed by the parties. (e) Severability. If any provi-
sion hereof is rendered ineffective or invalid, such provision shall not invalidate
any other provision. (f) Setoff. Buyer shall have no right to set off any amounts
against the amount owing in respect of this invoice. (g) Definitions. As used
herein, “including” means “including without limitation”; and “Omron Compa-
nies” (or similar words) mean Omron Corporation and any direct or indirect
subsidiary or affiliate thereof. 

Certain Precautions on Specifications and Use
1. Suitability of Use. Omron Companies shall not be responsible for conformity

with any standards, codes or regulations which apply to the combination of the
Product in the Buyer’s application or use of the Product. At Buyer’s request,
Omron will provide applicable third party certification documents identifying
ratings and limitations of use which apply to the Product. This information by
itself is not sufficient for a complete determination of the suitability of the Prod-
uct in combination with the end product, machine, system, or other application
or use. Buyer shall be solely responsible for determining appropriateness of
the particular Product with respect to Buyer’s application, product or system.
Buyer shall take application responsibility in all cases but the following is a
non-exhaustive list of applications for which particular attention must be given:
(i) Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.
(ii) Use in consumer products or any use in significant quantities.    
(iii) Energy control systems, combustion systems, railroad systems, aviation
systems, medical equipment, amusement machines, vehicles, safety equip-
ment, and installations subject to separate industry or government regulations. 
(iv) Systems, machines and equipment that could present a risk to life or prop-
erty. Please know and observe all prohibitions of use applicable to this Prod-
uct. 
NEVER USE THE PRODUCT FOR AN APPLICATION INVOLVING SERIOUS
RISK TO LIFE OR PROPERTY OR IN LARGE QUANTITIES WITHOUT
ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO

ADDRESS THE RISKS, AND THAT THE OMRON’S PRODUCT IS PROP-
ERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.    

2. Programmable Products. Omron Companies shall not be responsible for the
user’s programming of a programmable Product, or any consequence thereof. 

3. Performance Data. Data presented in Omron Company websites, catalogs
and other materials is provided as a guide for the user in determining suitabil-
ity and does not constitute a warranty. It may represent the result of Omron’s
test conditions, and the user must correlate it to actual application require-
ments. Actual performance is subject to the Omron’s Warranty and Limitations
of Liability. 

4. Change in Specifications. Product specifications and accessories may be
changed at any time based on improvements and other reasons. It is our prac-
tice to change part numbers when published ratings or features are changed,
or when significant construction changes are made. However, some specifica-
tions of the Product may be changed without any notice. When in doubt, spe-
cial part numbers may be assigned to fix or establish key specifications for
your application. Please consult with your Omron’s representative at any time
to confirm actual specifications of purchased Product. 

5. Errors and Omissions. Information presented by Omron Companies has been
checked and is believed to be accurate; however, no responsibility is assumed
for clerical, typographical or proofreading errors or omissions.



                   Note: Specifications are subject to change.                          © 2008 Omron Electronics LLC                                     Printed in U.S.A.

OMRON ELECTRONICS LLC • THE AMERICAS HEADQUARTERS
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